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ÚVOD  
 
V této semestrální práci se zabývám katastrálním územím Kokořín (667994), které leží severně od 
Mělníka směrem k České Lípě v okrese Mělník. Leží v Chráněné krajinné oblasti Kokořínsko – Máchův 
kraj. Patří mezi harmonické krajiny s charakteristickým reliéfem, jejíž ráz je spoluutvářen dlouhodobou 
lidskou činností. Vznikala zde řada unikátních společenstev s výskytem chráněných a vzácných 
rostlinných i živočišných druhů. Krajinný ráz je tvořen souborem přírodních a člověkem vytvářených 
podmínek daného prostoru. Na hodně místech je ovlivňován způsobem lesnického hospodaření. 
Kokořínsko je kulturní krajina pískovcové oblasti s výraznou členitostí charakteru členité pahorkatiny.  
 
Území patří také mezi Evropsky významné lokality – EVL Kokořínsko a je také chráněné v rámci Natura 
2000. V katastru se nachází také Přírodní rezervace Kokořínský důl.  
 

 
Katastrální území Kokořín (č. 667994) 

 
 
Během 4 cvičení se dozvídáme zajímavé informace o území a zároveň získáváme dovednosti 
v moderních systémech GIS (Geografické Informační Systémy). Pracujeme v programu ArcMap 10.5.  
Výsledkem práce je série map s textovou částí, kde je popsán postup tvoření každé mapy.   
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CVIČENÍ 1 

VYUŽITÍ ÚZEMÍ KÚ KOKOŘÍN 
 
Nejdříve v programu ArcMap 10.5 založíme nový pracovní projekt s názvem 
2017_KAZP_Prijmeni_01.mxp. Dále přidáme novou vrstvu Ortofotomapy pomocí ArcGis online, která 
bude sloužit jako podkladní vrstva pro naší mapu.  

 
Zdrojová data pro vytvoření mapy jsme získali na registru LPIS 
http://eagri.cz/public/app/eagriapp/lpisdata/, kde jsme pod číslem katastru zvoleného území (Kokořín 
667994) vyexportovali data LPIS DPB ve formátu SHP. Tuto databázi jsme přidali do mapy a nalezli 
vhodné měřítko řešení. Ve vlastnostech vrstvy (Layer Properties) v sekci FIELDS jsme zaškrtli pole, které 
nás zajímají – NKOD_PBD, platnyod, vymeram, kulturanaz, svazitost. V sekci SYMBOLOGY jsme dále 
nastavili barvy pro „Způsob využití pozemku“ a zapnuli značení jednotlivých pozemků.  

 
 
Po přepnutí do Layout view jsme vytvořili mapu formátu A4 orientovanou na výšku (File -> Page and 
Print Setup). Nastavili jsme vhodné měřítko zobrazení, vložili popisky, měřítko a severku (v horní liště 
políčko Insert). Mapu jsme vyexportovali jako soubor PNG.  
 
Vyexportovali jsme si také tabulku atributů vrstvy LPIS ve formátu excel pomocí příkazu Table To Excel 
(Converts a table to a Microsoft Excel file).  Tato tabulka slouží jako podklad pro zpracování statistik 
daného KÚ.  
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Statistiky pro KÚ Kokořín: 
Plocha katastru  
1 640,91ha  
 
Celková výměra ZPF dle LPIS (% z celkové plochy katastru) 
247,37ha -> 15,08%  
 
Výměra OP a výměra TTP celkem (% z celkové plochy katastru) 
 Výměra orné půdy    236,68ha -> 14,42% 
 Výměra trvalého travního porostu       9,26ha ->   0,56%  
 Výměra trvalé kultury        1,43ha ->   0,10%  
 
Počty pozemků v kategoriích  
 Počty pozemků v kategorii OP     14 
 Počty pozemků v kategorií TTP     9 

Pozemek trvalá kultura    1 
 
Celkový počet pozemků v daném katastru  
24 
 
Průměrná plocha jednoho pozemku  
10,31ha  
 
Průměrná plocha pozemku OP a pozemku TTP  
 Průměrná plocha pozemku OP   16,91ha  
 Průměrná plocha pozemku TTP     1,03ha  
 

 
Export atributové tabulky LPIS  

 
 

V řešeném území je nejvíce standartní orné půdy. Dále tam jsou plochy trvalého travního porostu a 
jeden pozemek trvalé kultury.   
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CVIČENÍ 2 

SKLONY NA POZEMCÍCH LPIS 
 
Pokračujeme ve vytvořené mapě na minulé hodině – Mapa využití území KÚ Kokořín, kterou pře 
uložíme pod novým názvem. Do internetového vyhledávače Google zadáme wms1 cuzk. Na webové 
stránce ČÚZK v přehledu služeb najdeme WMS – Územní jednotky. Zkopírujeme odkaz 
http://services.cuzk.cz/wms/local-ux-wms.asp?, který vložíme pomocí Add WMS Server (Catalog -> 
GIS Servers -> Add WMS Server).  Po vložení je třeba vrstvě nastavit souřadný systém na 
GCS_WGS_1984. Zobrazí se nám mapa hranic katastrálních území. 
 

 
 
Z ArcCR500 jsme naimportovali náš vybraný katastr. Poté ořízneme vrstvu LPIS půdních bloků pomocí 
nástroje CLIP (Analysis) 2dle plochy nově editovaného katastru. Díky tomu získáme data půdních bloků 
pouze uvnitř našeho katastrálního území (KÚ Kokořín).  
 
Po ořezání ploch vyexportujeme tabulku stejně tak jako ve cvičení 1. V této tabulce se automaticky 
vytvoří dva nové sloupce pro upravené půdní bloky – Shape_Length (obvod) a  Shape_Area (plocha). 
Sloupeček Shape_Area v další části (Statistiky pro KÚ Kokořín) porovnáme s předchozí výměrou ploch 
ze cvičení 1.  
 
Pro vizualizaci pozemků dle sklonitosti použijeme vizualizaci škálou pro 5 tříd dle svažitosti (Layer 
Properties -> Symbology -> Quantities -> Graduated colours, Value: SVAZITOST). V Layer Properties 
také vložíme nad každý pozemek popisky skutečné svažitosti.   
 
V Layout view vytvoříme mapu po vzoru Mapy využití území KÚ Kokořín (cvičení 1) – upravíme popisky, 
datum, zdroje…  

1 WMS = webové mapové služby  
2 Nástroj CLIP Analysis můžeme vyhledat pomocí funkce SEARCH  
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Statistiky pro KÚ Kokořín: 
POROVNÁNÍ SE CVIČENÍM 1  
původní hodnoty s přesahem přes hranice KÚ (cvičení1) X nové hodnoty po ořezu hranicí KÚ 
 

Plocha KÚ 
1 640,91ha 

Počet pozemků  Výměra (ha) 
Cvičení 1       Cvičení 2 

Výměra (%KÚ) 
Cvičení 1       Cvičení 2 

Všechny pozemky LPIS 24 247,37 216,94 15,08 13,22 
Orná půda 14 236,68 206,25 14,42 12,56 
Trvalý travní porost 9     9,26 9,26   0,56 0,56 
Jiná trvalá kultura 1     1,43 1,43   0,10 0,10 

 
  
Průměrná plocha jednoho pozemku  
10,31ha  X  8,91ha  
 
Průměrná plocha pozemku OP a pozemku TTP  
 Průměrná plocha pozemku OP   16,91ha  X 14,73ha  
 Průměrná plocha pozemku TTP     1,03ha  X               1,03ha  
 
 
Export atributové tabulky LPIS  

  
 
Po ořezu hranicí katastrálního území se zmenšila plocha orné půdy. Trvalý travní porost a jiná trvalá 
kultura mají stále stejně velkou plochu. Průměrná plocha jednoho pozemku se zmenšila z 10,31ha na 
8,91ha.  
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CVIČENÍ 3 

ODTOKOVÉ POMĚRY POZEMKŮ KÚ KOKOŘÍN 
 
I v tomto cvičení opět navazujeme na vytvořenou mapu z minulé hodiny – Mapa sklonů na pozemcích 
LPIS. Pomocí ArcGIS online vyhledáme digitální model terénu DMR4G3 (stínovaný model reliéfu České 
Republiky). Abychom natáhli vrstvu neupraveného výškopisu, musíme ve vlastnostech této vrstvy 
změnit vizualizaci vrstvy na None (pravé tlačítko myši na vrstvě DMR4G -> Properties -> Processing 
Teplates -> Function: None).  
 
Vrstvu stínovaného reliéfu ořízneme pomocí nástroje Clip (Data management) podle obrysu katastru 
(bez ořezání ploch). Poté znovu použijeme nástroj Clip (Data management) a ořízneme DMR4G na 
území pozemků LPIS pouze na plochy pozemků.  Při tomto druhém použití nástroje Clip nesmíme 
zapomenout zaškrtnout v tabulce volbu Use Input Features for Clipping Geometry (optional).  
 
Pomocí několika příkazů vytvoříme mapu, která bude obsahovat analýzu pozemků na náchylnost a 
produkci povrchového odtoku. Vstupní vrstva bude vždy vrstva vytvořená předchozím příkazem. 
Nejprve použijeme příkaz Fill4 (Tools -> Fill (spatial analyst)) se vstupní vrstvou DMR4G_pozemky 
(oříznutý model na plochu pozemků). Dále použijeme příkaz Flow direction5 (Tools -> Flow direction) 
a poté Flow accumulation6 (Tools -> Flow accumulation).  
 
Výstupem posledního příkazu Flow accumulation (počítá odtok – buňky) získáme vrstvu FlowAcc – 
vrstvu potenciální odtokové sítě. Zobrazení výstupu vizualizujeme pomocí obrácené škály barev – od 
světlé do tmavé barvy. Díky tomu se nám údolnice (dráhy soustředěného odtoku) zabarví na tmavou 
barvu a jsou tak lépe viditelné. Toto zobrazení nastavíme ve vlastnostech vrstvy (Layer properties -> 
Symbology -> Stretched -> Type: Histogram Equalize.  

 

3 Pro zjednodušení používáme DMR4G z prostředí ArcGIS online. Pokud bychom DMR4G přidali jako WMS vrstvu 
ze serveru ČUZK postupem z minulého cvičení, nebude to fungovat. WMS nelze editovat ani vyříznout. Proto 
využíváme formu z ArcGIS, kde je editace možná.  
4 Nástroj Fill – vyplňuje model terénu  
5 Nástroj Flow direction – počítá směrování  
6 Nástroj Flow accumulation – počítá akumulaci odtoku  
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Výsledné hodnoty nám říkají, kolik buněk (pixelů) do daného místa přiteče. Čím dále jsme po údolnici, 
tím je hodnota vyšší. Rozvržení našich pixelů je 5x5m.  
 
Dále budeme pokračovat krokem pro výpočet potenciální náchylnosti pozemku k produkci 
soustředěného povrchového odtoku. Použijeme příkaz Zonal statistics as table (vyhledáme pomocí 
SEARCH). Vstupními vrstvami použijeme v tomto pořadí: LPIS, NKOD_DPB a FlowAcc. Výsledná tabulka 
obsahuje hodnoty akumulace jednotlivých pozemků. Nás zajímají pouze průměrné hodnoty, hodnoty 
v poli MEAN připojíme k původní vrstvě LPIS pomocí příkazu Join field. 
 
Průměrné hodnoty akumulace zobrazíme barevnou škálou jednotlivých pozemků. Nejprve 
zkopírujeme původní vrstvu LPIS – půdních bloků. Vrstvu duplikujeme pomocí zmáčknutí klávesy CTRL 
a následného tažení vrstvy. Ve vlastnostech zkopírované vrstvy změníme zobrazení v sekci Symbology 
Fields – Value položku Svazitost na položku MEAN.  
 
Na závěr upravíme desetinná místa hodnot, která zobrazuje barevná škála, ve vlastnostech pomocí 
sloupce Label a zvolením Format Labels.      
 

 
 
 
Výstupem cvičení jsou dvě mapy, které ukazují odtokové poměry na Kokořínsku. Jsou doplněné 
legendou a všemi náležitostmi, které má mapa mít.  
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CVIČENÍ 4 

POPIS JEVŮ A ZMĚN V ÚZEMÍ KÚ KOKOŘÍN  
 
Cílem tohoto cvičení bylo popsat jevy a změny v řešeném území, které jsme na základě analýzy 
historických podkladů k danému území zjistili. Hledali jsme v různých mapách zejména na těchto 
webových stránkách: http://www.gepro.cz/support/wms-sluzby-v-cr-2017/ 

          http://eagri.cz/public/web/mze/farmar/LPIS/uzivatelske-prirucky/wms-sluzby/ 
          http://geoportal.vumop.cz/ 
          http://kontaminace.cenia.cz/ 

                                      https://mapy.cz/ 
          http://archivnimapy.cuzk.cz/  

 
Naučili jsme se do programu ArcMap 10.5 vkládat obrázky (výstřižky) z map, které jsme našli na webu. 
Tyto uložené obrázky jsme přetáhli na pracovní plochu z Catalogu a použili funkci Georeferencing. 
Pomocí několika bodů (georeferenčních bodů) jsme daný obrázek umístili na správné místo.  
 
Pro srovnání nynějšího stavu jsme využili také archivní ortofotomapy od 90. let, které jsme vyhledali 
na stránce Služby Esri ArcGIS Server (geoportal.cuzk) a přidali pomocí zkopírováním webové stránky a 
vložením v Catalogu do add wms server.  
 
ZMĚNY V OBCI KOKOŘÍN A JEJÍM OKOLÍ  
V této části cvičení jsem se zabývala změnou okolní krajiny obce Kokořín a také tím, jak se obec vyvíjela 
a měnila svou zástavbu. V písemných pramenech se obec Kokořín poprvé objevuje v roce 1320, v 
souvislosti s výstavbou gotického hradu ukrytého v lesích. Nově vzniklá obec v podhradí fungovala jako 
správní a zásobovací centrum pro obyvatele hradu.   
 

1. Vojenské mapování obce   
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Mapa 1: 19. století  
Na této mapě jsem si zkusila vložení obrázku pomocí funkce georeferencing. Zdrojem je server mapy.cz 
a mapa z 19. století. Archivní mapový podklad tvoří mapy z let 1836-1852 a zobrazuje území před více 
než 150 lety. Obcí vedla císařská silnice 1. třídy a na návsi přibývá nový rybník. Na první pohled nás 
zaujme v obci dvůr – zámek Kokořín z 18. století, který bývá často opomíjen díky hradu Kokořín.  
 

  
zdroj: http://www.stredoceske-zamky.cz/zamekkokorin.html 

 
Pro větší přehlednost přikládám výstřižek z mapy Stabilního katastru z roku 1842. Mapa pomocí 
funkce georeferencing není v moc dobré kvalitě kvůli velkému přiblížení.   
 

 
zdroj: http://www.geolab.cz/kokorin/kokorin/kokorin.htm  
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Mapa 2: Rok 1954   
Tato mapa ukazuje historické dělení pozemků, které byly později scelovány. Scelování pozemků 
probíhalo v celém Československu v letech 1948 – 1960, kdy probíhala kolektivizace. Další scelování 
pozemků družstvem bylo v 70. letech podle Generelů pozemkových úprav. Scelováním pozemků 
docházelo k neodborným a násilným zásahům do krajiny, které byli pro dosavadní krajinu devastující. 
Byla narušena ekologická stabilita a začalo docházet k častým erozím nebo úbytku volně rostoucí 
přírodní zeleně.  
Mezi nescelenými pozemky jsou viditelné cesty, které při scelování zanikly. Například cesta na 
jihozápadu, která na této mapě vypadá, že byla i lemována stromy.  
 
Mapa 3: Rok 1999 
Oproti mapě 2 z roku 1954 se díky scelování pozemků mění struktura zástavby vesnice na severu. 
Z členění pozemků na mapě 2 by domy měly být podél historické cesty. Z křižovatky však vzniká úplně 
nová ulice s čtyřpodlažními bytovými domy. Uvnitř obce přibývá také několik dalších bytových domů.  
Dále se mění zelený park u zámku na halu s asfaltovým parkovištěm.  
V jižní části řešeného území (dole na mapě) přibývá zalesněná plocha.  
 
Mapa 4: Rok 2003  
Pro další porovnávání ortofotomapa z roku 2003, kde je viditelná další úprava pozemků. Zástavba 
v obci nepřibývá.  
 
Mapa 5: Rok 2017 – Současný stav  
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ZÁVĚREČNÉ VÝSLEDKY  
 
Z první mapy – Mapy využití území se dozvídáme, že v řešeném území se nachází nejvíce ploch orné 
půdy kolem 14,5% z celé plochy katastru. Kromě orné půdy jsou zde také pozemky v kategorii trvalého 
travního porostu a jeden pozemek trvalé kultury, který zabírá 0,10% z plochy katastru.  
 
Druhá mapa – Mapa sklonů ukazuje svažitost pozemků v procentech. Svažitost pozemků se pohybuje 
od 1,7 do 9,93%.  
 
Třetí mapa – Mapa odtokových poměrů ukazuje místa, kde voda nejvíce stéká a kde je největší 
pravděpodobnost eroze půdy. Analyzovali jsme tak pozemky z hlediska náchylnosti k produkci 
povrchového odtoku.  
 
Tím, že se oblast nachází v CHKO od roku 1976 a je to Evropsky významná lokalita, nebylo lehké najít 
na mapách nějaké výrazné změny. Zabývala jsem se obcí Kokořín a jejím okolím, kde mne zaujalo 
scelování pozemků. Díky tomu se například nová zástavba v obci vyvíjela jinak než by se dalo očekávat. 
Na sérii map můžeme sledovat další změny v okolní krajině – například zánik několika cest nebo 
rozšiřování lesních ploch.  
 
 
 
 
 
 

ZDROJE 
 
http://www.geolab.cz/kokorin/1vm/koko_1vm.htm  
http://www.stredoceske-zamky.cz/zamekkokorin.html  
http://www.geolab.cz/kokorin/kokorin/kokorin.htm  
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